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1 First Things First

1.1 COPYRIGHT

Copyright ©1998 by Polhemus Incorporated

Colchester, Vermont U.S.A.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system,
or transmitted, in any form or by any means, mechanical, photocopying, recording or
otherwise, without the prior written permission of Polhemus Incorporated. No patent liability is
assumed with respect to the use of the information contained herein. While every precaution
has been taken in the preparation of this book, Polhemus Incorporated assumes no
responsibility for errors or omissions. Neither is any liability assumed for damages resulting
from the use of the information contained herein.

STAR★ TRAK® is a registered trademark of Polhemus Incorporated.

1.2 READER’S GUIDE AND GLOSSARY

Throughout this manual, the following conventions are used. Words surrounded by “<” and “>”
represent keys on your StarTrak system keyboard. For example, the control key is printed like
this

<Ctrl>

When groups of keys should be pressed and held they are printed like this:

<Ctrl> + <Alt> + <Del>

When prompts and messages appear on the screen or commands that are to be typed, they
appear in a different typeface. For example:

All Sensors Active

Throughout this manual, the word “receiver” is used synonymously with the word “sensor.” The
terms are used interchangeably to refer to the miniature antennae that are placed on the object
to be tracked.
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1.3 WARNING

Warning, Shock Hazard !!!

Before operating your StarTrak system, make certain that the StarServe, StarDrive Unit and
the monitor are properly grounded by connection to three-terminal grounded power
receptacles.

The voltages developed in the optional SuperNova transmitter(s) can be high enough to create
a shock hazard. Do not touch, handle or place conductive material near these units while in
operation.

DO NOT connect or disconnect the Long Ranger or SuperNova transmitter(s) to/from the
StarDrive Unit when powered, as this will cause severe damage to both StarTrak components.

1.4 CUSTOMER SERVICE

If problems are encountered with the StarTrak equipment, help is just a telephone call away.
Call Polhemus and ask for Customer Service. For the most part, our Customer Service
engineers can handle your problems over the telephone and get you back into the fast lane
right away. If the problem requires repair of your instrument, the Customer Service engineer
will issue a Return Merchandise Authorization (RMA) number. It is a good idea to keep the
original shipping container for your StarTrak instrument in the event that the instrument may
require repair. Please do not return any instrument without an RMA number as it will not be
accepted. If your instrument is still under warranty, Polhemus will repair it free of charge
according to the provisions of the warranty as stated in Section 9 of this document. The proper
return address is:

Polhemus Incorporated

1 Hercules Drive

Colchester, Vermont 05446

Attention: RMA # ______

Telephone (Voice): (802) 655-3159

Telephone (Voice): (800) 357-4777

Telephone (FAX): (802) 655-1439
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2 System Specifications

2.1 STARTRAK SYSTEM SPECIFICATIONS

Environment

Operating volume no larger than a 12ft. (3.6 m) radius. The environment must be calibrated in
order to provide specified performance. Specified performance will be provided in this volume,
with somewhat degraded performance outside that central volume. Minimum separation
(transmitter center to receiver distance) is 1.5 ft. (0.5 m).  Use of the optional Super Nova
transmitter extends the maximum specified performance range to 18 ft. (5.5 m) and minimum
separation to 5 ft. (1.5 m).

Receivers

Up to 16 Receivers on each of 2 actors, for a total of 32 Receivers.

TrakBelt

One per actor, for a total of 2. Contains the electronics assemblies to acquire receiver signals,
digitize and format data, and transmit to StarServe. Belts are powered by rechargeable
batteries, which also are housed in the belt.  Provisions are made for operation with either one
or two batteries.

Operating Modes

Wireless Mode: No cables will connect actors with servers. Actors' motions will be captured for
a period of time limited by the TrakBelt’s battery capacity.

Tethered Mode: A thin, 1/4 in. cable connecting each actor with the StarTrak  Motion Capture
Server will allow capture of actors' motions for long periods of time:  1 hour, 1 battery;  2 hours,
2 batteries;  16 receivers.
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Battery Time - Wireless

At least 90 minutes, two batteries and 16 receivers.

Update Rate

120 Hz. per Receiver,  independent of the number of receivers.

Client Interface

Ethernet, UDP Protocol

Transmitters

An arrangement of transmitting antennas sufficient to provide the performance specified
herein. The Long Ranger is supplied standard.  The Super Nova is optional and can extend the
operating range, usually by 30% - 40%.

Absolute Accuracy

The absolute dimensional accuracy of the position and orientation reported by each Receiver
in the Calibrated Volume.

Position:  1 in. (2.5 cm) mean value over 100 samples. Standard deviation of 0.4 in. (1
cm)

Orientation:  1° (2.5 cm) peak

Repeatability

Within system accuracy,

Position:  0.5 in. (1.3 cm)

Orientation:  2°

Range

With Long Ranger Transmitter: 1.5 ft. (0.5 m) to 12 ft. (3.6 m) radius

With Super Nova Transmitter: 5 ft. (1.6 m) to 18 ft. (5.5 m) radius

NOTE: Operation in a distortion-free environment with the Super Nova requires calibration.
This may not be necessary with the Long Ranger.



Star★★★★ Trak User Guide v001B

System Specifications 2-5

Measurement Limits

Six degree-of-freedom sensing. No line-of-sight limits.

Operating Temperature

10°C-40°C at 10%-90% RH, non-condensing

Physical Characteristics

Motion Capture Server  -- StarServe

Configuration:  Tower

Size:  16.5” (41.9 cm) L x 7.25” (18.4 cm) W x 17.5” (44.4 cm) H

Weight:  61 lbs.

Receiver

Size:  Approximately 1.19” (30 mm) x .75” (19 mm) x .75 (19 mm)

Weight:  1.0 oz. (30 g)

Transmitter Driver – StarDrive

Configuration:  Mini-tower

Size:  14.25” (36.2 cm) L  x  7.5” (19 cm) W  x 14.5” (36.8 cm) H

Weight:  17 lbs.

TrakBelt

Configuration:  Cloth belt with pocket for 1 StarPak electronics module and two batteries

Available Sizes:  Small (33.25” x 8”);  Medium (40” x 8”);  Large  (49” x 8”)

StarPak

Size: 6” (15.2 cm) x 6” (15.2 cm) x 2.5” (6.4 cm)

Weight:  4.5 lbs. with 16 receiver ports and wireless link.

StarLink

Size:  11” (27.9 cm) L (incl. antennas) x 5.5” (14 cm) W  x 1.5” (3.8 cm) H

Weight:  1.5 lbs. (with dual units)
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3 StarTrak System Description and Components

3.1 INTRODUCTION

The overall StarTrak system interconnect encompasses the following main components:

StarServe – The central control unit for the StarTrak system. Part number 4A0436-01.

StarLink RF Interface – A Spread Spectrum radio transmitter and interface unit used to
communicate with the StarPack Assemblies. Two different configurations are available: Part
number 4A0438-01 for a 1-actor RF wireless unit or 4A0438–02 for a 2-actor wireless unit.

Calibration Fixture – The StarTrak environment calibration pole system. Part number
4A0443-01.

Long Ranger Transmitter – An apparatus that creates a low-level magnetic field throughout
the motion capture volume. Part number 4A0345-02.

StarDrive Unit – An electronics unit that receives low power signals and amplifies them to
drive the transmitter. Part number 4A0426-01.

Receiver – A miniature antenna, placed on the object to be tracked that receives the
transmitted magnetic fields. StarTrak can simultaneously operate up to 32 receivers per
system. Three different cable length configurations are available: Part number 4A0434-01,
4A0434-02, and 4A0434-03.

StarPak – Synchronizes the sensing of the magnetic fields, collects sensed data, converts
data to digital form and transmits data via tether or wireless to the StarLink. Two configurations
are available: An 8-input unit is part number 4A0435-01 and a 16-input unit is 4A0435-02.

StarLink – Provides the wireless link to/from the StarPak(s) and interfaces the StarServe via
its internally housed special MAC board. Part number 3A0602.

Host Computer – The system utilizing the StarTrak motion capture data. The data is received
via the Ethernet connection.

The remainder of this chapter will describe all of the StarTrak components in detail. Please
check to ensure that you have received all of the StarTrak components listed in this manual.
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3.2 DETAILED COMPONENT DESCRIPTIONS

Battery Pack

Figure 3-1  Battery Pack

The StarTrak Battery Pack consists of a long-life Lithium Ion battery capable of powering a
single StarPak for approximately 1 hour between charges. One battery pack will operate up to
16 receivers.
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Battery Charger

Figure 3-2  Battery Charging Unit

The battery charger unit is provided to charge the Lithium Ion battery pack. The charge time is
approximately 1.5 hours.
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Calibration System

Figure 3-3  Calibration fixture

The StarTrak calibration fixture consists of a modular pole where the calibration receivers are
mounted in a known position and orientation. This fixture is used to model the environment for
the motion capture space.
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Ethernet Cables

Figure 3-4  10Base2 (left) and 10BaseT (right) Ethernet Cables

The Ethernet cables provide a high-speed data pipe to external data processing equipment.
Both Real Time and recorded motion capture data may be transmitted over this link.
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Keyboard, Monitor, and Mouse

Figure 3-5  StarServe, Keyboard, Monitor and Mouse

The keyboard, monitor and mouse provide a means for interfacing with the StarTrak system.



Star★★★★ Trak User Guide v001B

    StarTrak System Description and Components3-12

StarServe

Figure 3-6  StarServe

The StarServe is the central control unit of the StarTrak system. It is built upon a Windows NT
platform and performs numerous functions in addition to providing real-time motion capture
data. A few key functions are described here:

Position & Orientation Solution – The Server performs the sophisticated position and
orientation calculations.

MAC Board – Installed in the StarServe is a special circuit board that performs two functions:
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1. StarDrive Excitation – The Server provides the unique waveform that is amplified by
the Star Drive unit and then applied to the Long Ranger Transmitter.

2. StarPak Control and Data Acquisition – Used to communicate with the performers’
StarPak via tether cable and via Radio Link with the StarLink RF interface.

Network Connection – The server provides an Ethernet interface to your host computer.

Standard Receiver and Cable Assembly

Figure 3-7  Standard Receiver and Cable Assembly

A StarTrak receiver is a miniature antenna, placed on the object to be tracked, that receives
the transmitted magnetic fields. The StarTrak can simultaneously operate up to 32 receivers
per system. The receiver’s small size provides both comfort and good fit. Up to 16 receivers
can be connected to a single StarPak. See figure 3-7 above.

Receivers may also be referred to as “sensors” in this document.
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StarPak

Figure 3-8  StarPak Front View
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Figure 3-9  StarPak Back View

The StarPak is the interface between the 16 Receivers and the StarLink RF Interface. The
StarPak performs primary signal processing of the data provided by the Receivers,
conditioning it and getting it into digital format ready for transmission to the server.
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StarLink RF Interface

Figure 3-10  StarLink Front View
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Figure 3-11  StarLink Rear View

The StarLink RF unit interfaces the Spread Spectrum RF transceivers to the StarServe. The
transceivers provide the wireless data link between the StarServe and the StarPak. The
StarLink RF Interface can support communication for one or two StarPaks.
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Long Ranger Transmitter

Figure 3-22  Long Ranger Transmitter System with Tuning Module

The Long Ranger Transmitter is the “Antenna” or magnetic radiator of the StarTrak system. It
must be placed on a stable platform and oriented in a specific direction.

Warning:  Do not attach/remove the Long Ranger Transmitter to/from the Star Drive Unit when
it is powered on or it will cause severe damage to both units.
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Tether Cable

The Tether Cable is a conduit through which all the collected Receiver data may be sent to the
StarTrak StarServe for position and orientation processing. In non-wireless mode the Tether
remains connected to the performer. In wireless mode, the Tether is used only to initially
synchronize the StarPak with the StarServe. There exists one Tether per StarPak unit.

TrakBelt

Figure 3-33  TRAKBELT

The TRAKBELT is a simple harness worn around the performer’s waist that provides for easy
attachment of the StarPak and Battery Pack to the performer.
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StarDrive

Figure 3 44  StarDrive

The StarDrive unit receives low power signals and amplifies them to drive the transmitter.
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4 Step-By-Step System Installation

4.1 CONNECTING IT ALL TOGETHER

Overview

Figure 4-1 illustrates the overall electrical interconnect of the StarTrak system.
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StarServe

The StarTrak StarServe is a Pentium based, Microsoft NT workstation running the StarTrak
motion capture application. The server unit is comprised of the chassis, keyboard, mouse and
monitor. The chassis contains the receptacles for the other server components, the MAC
board and an Ethernet interface.

Mouse

The mouse is installed at the server chassis into a PS2 mini-DIN receptacle. All required
mouse drivers are pre-installed at the factory.

Keyboard

The keyboard is a standard AT style input device. It is connected at the rear of the server
chassis into a PS2 mini-DIN receptacle.

Monitor

The monitor is connected to the receptacle at the rear of the StarServe chassis with a standard
video cable. Refer to Figure 3-5. The monitor power cord must be attached to a standard
power receptacle. The monitor and chassis automatically operate at the proper voltage 100-
220V, 50-60Hz, depending on what is supplied.

StarLink RF Interface Unit

This unit interfaces the Spread Spectrum RF transceivers to the StarServe. It is connected to
the StarServe chassis via a 68-Position SCSI-III cable to the MAC board

StarDrive

The StarTrak Star Drive unit is connected to the StarServe chassis via a 15 position D-type
cable assembly. Similarly, it is attached to the Transmitter (Long Ranger, etc) via a xx position
D-type cable assembly. The Star Drive unit also must be attached to a standard power
receptacle and will operate at proper voltage (100-220VAC, 50-50-60Hz). A lighted power
switch is provided on the unit face panel. The StarDrive can be turned ON/OFF as the
StarServe turns ON/OFF.
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Long Ranger Transmitter Assembly

Figure 4-2  Long Ranger Transmitter Assembly and Cable Connection

When using the Long Ranger Transmitter, attach the turnbuckle the opening in the long ranger
and the bar inside the pedestal, as shown in Figure 4-2 above.
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Figure 4-3  Super Nova Transmitter

If the optional Super Nova Transmitter is used in lieu of the Long Ranger, attach its special
transmitter cable to the three connectors of the Super Nova Transmitter, matching the X, Y,
and Z labeled connectors. See Figure 4-3 above.

Transmitter Mounting

There are several techniques for mounting the Long Ranger Transmitter. The method shown
uses the Polhemus custom non-metallic Tripod. (Refer to the following instructions for
mounting the transmitter to the custom Tripod mount.) Mounting properly and securely is very
important since all measurements are made relative to its location.

1. Place the tripod in a low-traffic area to prevent accidentally disturbing the
transmitter. Avoid high-distortion areas such as those close to steel beams or
metallic siding.

2. Set up the tripod with the three legs positioned in a circle of at least 4 feet in
diameter for the lowest tripod height. Extension of the tripod legs will require that
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the legs be positioned in a circle of larger diameter to maintain stability. Secure a
restraining cord at the bottom of the legs to ensure stability of the assembly.

3. Place the transmitter mount on top of the tripod and fasten in place using the
three 1/2-2O UNC nylon bolts and washers as shown and tighten securely. See
Figure 4-5.

3. 4. Raise the transmitter and route the cables through the 2-inch
diameter hole in the base of the mount. Be sure that both the X and
Y coils are fully inserted into the notches provided.

4. 5. Install the mounting caps over the transmitter coils using the
fasteners provided and tighten securely.
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Figure 4-4  Tripod
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Figure 4-5  Long Ranger Transmitter Mounting Structure

Once the transmitter is mounted to the pedestal, attach the transmitter cable to the Long Ranger, and then set the

pedestal on top of the tripod base as shown in Figure 4-5 above.

System Interconnect

The overall system interconnect diagram (Figure 4-1) and the instructions that follow, will
describe how to set up the StarTrak system in the studio space.
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Layout Considerations

The StarTrak system is designed to operate over a space as large as 8 ft. x 16 ft. with a single
Long Ranger transmitter. A minimum range from the transmitter globe of approximately 1-foot
is also required; i.e. receivers should always be at least 1 foot from the transmitter. A typical
installation may have the transmitter mounted on a tripod, centered in front or back of the
working area. A setup geometry such as this will allow a maximum range from the center of the
transmitter to the corner of an 8-ft x 16-ft performance area to be 12 ft. It is also recommended
that a non-metallic stage be built, two to three feet high. This will allow the system to be farther
away from distorting materials contained in most floors.

The StarTrak system measures position and orientation based on the relative positions of the
transmitter and receivers. Therefore, stable mounting of the transmitter is imperative. In
addition, the calibration process for the system requires that the transmitter be completely
stable during and after the calibration process. (If the transmitter is moved after a calibration
has been completed, then a new calibration is required.) Proper preparation of the transmitter
mount site must be considered and implemented prior to the start of a calibration.
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StarTrak Component Interconnect

Figure 4-6  Long Ranger Cable to Tuning Module

After securely mounting the transmitter and attaching the cable, connect the other end of the
cable to the tuning module as shown in Figure 4-6 above.
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Figure 4-7  StarDrive Connections

Attach the transmitter cable from the tuning module to the right hand connector on the
StarDrive labeled “Driver out.” Then attach the StarDrive cable to the left-hand connector on
the StarDrive labeled “Driver in” as shown in Figure 4-7 above.
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Figure 4-8  StarDrive to StarServe Connection

Connect the Server-Driver Cable from the “Drive In” connector on the StarDrive to the DB15
connector on the back of the StarServe. See Figure 4-8 above.
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Figure 4-9  StarLink to StarServe Connection

If the RF transceiver card is installed in the StarPak, connect the StarLink via the SCSI,
Server-Link Cable to the StarServe. See Figure 4-9 above. This establishes the RF link. If the
RF transceiver card is not installed do not connect the StarLink.
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Figure 4-10  Tether to StarServe Connection

Connect one end of the tether to Port A at the back of the StarServe. See Figure 4-10 above.
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Figure 4-11  StarPack to Tether Cable Connection

Connect the other end of the tether cable and the receiver cables to the StarPak as shown in
Figure 4-11 above. You should hear a “click” when each receiver connector has been seated
properly.

Ensure that the Star Drive excitation cable is installed between the Star Drive Unit and the
StarServe. The power cord to the Star Drive unit also must be installed. Turn the Star Drive
power switch to the “ON” position (lighted). Note: Since the StarDrive power is connected to
the StarServe, turning the StarServe power off automatically turns off the StarDrive power.
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Receivers

The small receivers are designed to provide a stable base to prevent unwanted rotational
movement when affixed to an actor. Three cable lengths are provided and should be carefully
placed so that adequate movement without tugging on the receiver is achieved but without
leaving cable loops to catch onto objects.

It is also important to record which sensor port on the StarPak is used to connect to which
body part so that the host software can be initialized accordingly.

Figure 4-12  Receivers, various cable lengths
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Figure 4-13  Receiver Mounting Kit

The receivers are mounted to the Performer’s suit with the help of the “Receiver Mounting Kit.”
This kit consists of multi-colored cable markers, a 10 meter roll of double sided Velcro tape, a
hole punch, a punch template and push rivets. The Velcro is cut to correct lengths for attaching
the receivers to the performer. Using the punch template as a guide, mounting holes are cut
into the Velcro with the punch tool. Punch rivets (pushed through the Velcro and receivers),
are used to retain the receivers to the Velcro. See Figure 4-13.
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TrakBelt

Figure 4-14  TrakBelt

Figure 4-14 illustrates the TrakBelt and the positioning of the StarPak and battery. For the
user’s convenience, the Belt is shipped pre-assembled. If the Belt is disassembled please note
the positioning and routing of the cables to aid in re-assembly.

Ethernet Connection

The StarTrak StarServe provides output via Ethernet cables (10Base T or 10Base 2). Connect
to the appropriate connector on the Ethernet board at the rear of the server. All Ethernet
drivers are pre-installed. Polhemus has provided a special 10 Base T Crossover Ethernet
cable. This cable will allow direct connection with a host machine without the use of an
Ethernet Hub. If a standard 10 Base T cable is used, then a Hub must be utilized.
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4.2 STARTING UP STARTRAK

Start the Server

After the system is fully connected as described above, turn on the system power at the
StarServe (front panel power switch). The system will go through CPU diagnostics and boot
into the Windows NT workstation desktop.

Launch the StarTrak monitor application by double clicking the StarTrak icon on the desktop.

Launch the StarTrak Application

Launch the StarTrak application by double clicking the StarTrak icon   on the
desktop. The StarTrak main window will appear with the Status window active. If there are any
problems with this launch (driver startup, etc), error messages will be displayed in the status
bar at the bottom of the window and recorded in the error log.

Start the MAC

Figure 4-15  StarServe Main Window

Start the StarTrak Media Access Controller (MAC). Select the “START” button on the STATUS
window of the StarTrak monitor. Several “load” message windows will appear followed by the
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message “MAC Started” displayed in the status message dropdown box (of both channels).
Again, if there are problems with this part of the startup procedure, error messages will be
displayed and logged.

Power up StarPack

Prepare to receive StarPak data. Connect the StarPak battery, located on the TrakBelt, to the
StarPak. A series of messages should be displayed in the status message dropdown box(s).
When the  “Mac Characterization Xfer Done” message is displayed, select the “SYNC”
button. Upon reception of the “Calibration Complete” message, field data, P&O data,
characterization data, and calibration data may be reviewed.

Verify Active Sensors

Figure 4-16  Channel Sensors View

Verify the number of active sensors in the “Channel Sensors View.” Upon selecting the
appropriate “Sensors” button, review the active sensor list. A checked box denotes an active
sensor (receiver). If the number and position of the connected receivers do not match the list,
verify all connections and then select the “RESET” button. Upon reception of the “Mac
Characterization Xfer Done” message, select the “SYNC” button. When the “Calibration
Complete” message is displayed check the active sensor list again.
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Examine Sensor Characterization and Calibration Data

Figure 4-17  Sensor Characterization Data Display

As a quick check of sensor integrity, examine both the characterization and calibration data
sent by the StarPak to the StarServe. To check the characterization data, select
“Characterization Data” from the Diagnostics list in the main menu or select the
characterization icon on the toolbar. Scrolling through each sensor (next/previous buttons) the
diagonal elements (x,1 : y,2 : z,3) of the “frequency 3” matrix should have values between +20
and +25 or between –25 and –20. The magnitude of the remaining elements should be no
greater than 2. If no sensors are connected, the data will be meaningless.
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Figure 4- 18  Receiver Calibration Data Display

Calibration data may be viewed by selecting “Calibration Data” from the Diagnostics list in the
main menu or by selecting the calibration icon on the toolbar. Each receiver’s calibration data
may be examined by using the “next” or “previous” buttons. All magnitudes within the
calibration matrix should lie between 1900 and 2300 (signs may vary).

Display Field Data

Figure 4-19  Field Data Display

With all expected sensors listed, display the field data window. This window may be activated
by selecting from the main menu or by clicking on the toolbar icon. Scroll the screen to
examine that field data is presented for each sensor connected. There should be four columns
of data representing data from each winding of the transmitters - X, Y, Z and W. With one
transmitter present only the first three columns will contain data and the fourth column will
display small numbers close to zero. The field data should be reasonably stable in magnitude
and sign when the sensors are stationary and within 12 feet of the transmitter.
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Display Motion Data

Figure 4-20  Motion Data Display

The Motion Data window may be displayed by selecting it from the dropdown list on the main
menu bar or by selecting the Motion Data icon on the toolbar. Each sensor will display position
and orientation (P&O) values in seven columns (receiver number, X, Y, Z translation, azimuth,
elevation, and roll). At this point, however, these numbers will have limited meaning because
the motion capture space has not been calibrated. For diagnostic observations select Display
Field data from the menu.

Stopping StarTrak

Stopping the StarTrak system requires both shutting down the StarTrak application and
severing the RF link between the StarServe and the StarPak(s).

To terminate the StarTrak application on the StarServe, select “Exit” from the file menu or click

on the “close window” icon (in the main window), or click on the .

Removing power from the StarPak(s) terminates the RF link between the pack(s) and server.
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4.3 ENVIRONMENT MODEL

Before you Begin Using Data

The procedure to be performed here is most critical for StarTrak system installation. This
chapter describes how to build the environment model through a process referred to as an
Environment Calibration. The environment model is used to equalize unusual amounts of
metal that affect magnetic-based motion tracking systems. Therefore, this process should be
performed carefully to specification. Before proceeding, verify from the list below that all of the
required equipment is present. If you have difficulty in understanding this chapter, our
Polhemus technical support engineers are on-line ready to answer your questions.

Required Equipment

1. StarServe 4A0436-01

•  Cable, Tether A3L79b10BL-MW

•  Power Cord 17500-BLK

2. StarDrive 4A0426-01

•  Power Cord 17500-BLK

•  Cable, Server – Driver 2A0596-01

3. StarLink 4A0438-01 (Channel 1)

•  Cable, SCSI, Server-Link
DCA2775/MD68MM10

4. Long Ranger 4A0345-02

•  Cable, Driver- Tuning Module 3A0542-03

•  Tuning Cap Module, X, Y, Z 3A0583-01

•  Cable, Tuning Module – Long Ranger 3A0581-01

•  Tripod with Pedestal (optional) 2A0366-01

5. Calibration Fixture 4A0443-01

•  StarPak, RF 16 Receivers 4A0435-01-A (Channel
1)
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•  Battery Assembly (2) 2A0497-02

•  Cable, StarPak-Battery Y 2A0622-01

•  StarPak-Battery 2A0624-01

•  Receivers

1. 36” Receiver Assembly (4) 4A0434-01

2. 48” Receiver Assembly (5) 4A0434-02

3. 66” Receiver Assembly (7) 4A0434-03

Setting Up

Introduction

This section describes the hardware connections required to power up the StarTrak
system. Refer to the PC’s User Manual for instructions on connecting the PC and
accessories. Windows NT and the StarTrak software are installed at the factory.

Hardware Configuration

•  Calibration data can be collected wireless over the RF link or through the tether
cable. If the prism PCMCIA card is not installed, data collection is done through
the tether which remains connected throughout the calibration process.

•  Channel 1 or 2 wireless may be used for calibration. A factory set switch on the StarPak presets the
pack for either Channel 1 or 2 and is identified by the part number. For this discussion, Channel 1 will
be used. (Replacing 1 with 2 throughout this procedure will describe calibration using Channel 2
StarPak).

NOTE: The StarLink (4A0438-01) has Channel 1 only. StarLink (4A0438-02) is
required to establish an RF link over Channel 2.

•  Apply AC power to the StarDrive.

•  Connect the Tether Cable to the StarPak.

•  Assemble the Calibration Fixture as shown in Figure 4-21. Note: There are 3
different receiver cable lengths. Care should be taken when mounting the
receivers to the fixture to ensure that each receiver’s cable will reach the
StarPak’s location.
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Figure 4- 21  Calibration Fixture

•  Make certain the receiver’s position on the calibration fixture matches the
number on the StarPak when connecting.

Note: When performing an 8-receiver calibration rather than a 16, affix receivers to the
pole in “every other” position, starting at the bottom.

•  Securely fasten the batteries to the base of the calibration fixture. Connect the
batteries to the StarPak using the StarPak-Battery “Y” cable and the extender
cable.
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CAUTION: SECURE THE STARPAK BATTERY CABLE AWAY FROM THE RECEIVERS’
SHELLS & CABLES. CLOSE PROXIMITY BETWEEN THIS CABLE AND THE RECEIVERS
WILL RESULT IN ERRONEOUS DATA.

Software Configuration and Operational Setup

•  Power on the StarServe following the steps described in the PC User Manual.

•  Double-click on “STARTRAK.EXE” icon.

CAUTION: PRIOR TO INITIATING THE CALIBRATION CYCLE, MOVE THE FIXTURE AT
LEAST THREE FEET FROM THE TRANSMITTER TO ENSURE PROPER RECEIVER
CALIBRATION.

•  From the Status Window, click on the “Start” button.

1. “Mac Has Started” message will be displayed in the Channel 1 Display
window.

2. Wait for “Mac Characterization Xfr Done” message. Occasionally, messages
can be missed over the RF link and therefor, will not be received by the
operator. After 10 seconds with no indication of Mac characterization transfer
done, single-click on the “Reset” button and wait for the message. If the
server fails to receive the message again, look for an illuminated yellow LED
on the StarPak indicating a successful RF link. “Reset” the system. If the
yellow LED is still not lit or flashing, power down the StarPak and reapply
power. Return to Step X.X. If problem persists contact Customer Service at
Polhemus (800) 357-4777 (USA and Canada, only) or (802) 655-3159.

•  Single-click on the “Sync” Button.

1. “Calibration Cycle Started” message will be displayed in the Channel 1
Display window.

2. Wait for “Calibration Cycle Complete” message.

•  Single-click on “Calibration Data” icon of toolbar.

1. Check for approximately –1900 ➙  -2800 range.

2. Click on “Next” to view each receiver’s calibration data. Each one should fall
within this range.

3. If the data is outside the specified range, verify that the fixture is far enough
away from the transmitter and “Reset” the system. If the problem persists,
call Customer Service.

•  Single-click on “Characterization Data.”

1. The data on the left is the characterization matrix for the receiver. The data
on the right is the calibration data.

2. Click on “Next” to view each receiver’s characterization data
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3. In order to avoid connecting the receivers to the StarPak out of sequence,
verify that the last three digits of the displayed serial number matches with
the receiver’s serial number mounted in that position on the calibration
fixture.

•  If the server didn’t receive characterization data, check the receiver connections
and “Reset” the system. If the problem persists, call Customer Service.

•  Single-click on the “Setup” button and select the “Dipole” folder. Set the
hemisphere vector to the +X hemisphere.

1. Enter 1 for the X component and 0 for the Y and Z components.

•  A helpful aid in finding a good transmitter location is the “Motion View” screen.
Select the “Motion View” icon. This window shows a graphic representation of
the 16 sensor positions. (The transmitter position where the graphic of the line
of receivers stays the straightest will be the best position. The next section goes
into greater detail about finding a suitable Transmitter mounting position.)

Transmitter Location, Orientation and Hemisphere

•  Choose a transmitter location that is away from large distorting objects and
somewhat close to the motion capture space. Securely mount the Long Ranger
transmitter in an optimum location by using the following steps.

•  Position the transmitter orientation so that the +Z axis is pointing down towards
the ground. Typically, the +X hemisphere is used in the calibration process.
Therefore, the +X axis should point toward the motion capture space. Optimum
range between the transmitter and any collection point is 2 to12 feet.

•  Place the calibration fixture in several locations and observe the positions for all
the fixture’s receivers by using the “Motion View” and “Motion Data” windows in
the software. (Refer to the Software Section for details). Beware of an unusual
amount of error between the 16 receivers. With experience, you will be able to
judge whether or not a region can be successfully calibrated. If the error is too
large (+ or – 30 degrees of deviation, + or – 25 inches deflection), then
reposition the transmitter and repeat the test.

•  After determining a transmitter position that will produce a successful
calibration, securely mount the transmitter to its final location.

•  If there are future plans to move the Long Ranger transmitter, it must be
mounted in a manner such that it can be precisely repositioned to the exact
same physical position and orientation in order to preserve the environment
calibration.

Define the Mapping Grid

The grid pattern is defined in two places: (1) in the StarTrak software, and (2) on the
studio floor or stage. A twelve-inch grid pattern has been adopted to collect
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calibration data. This is not a standard. If a smaller or metric grid is required, then it
should be used. The maximum number of grid points in any direction is 180.

•  Create the desired grid pattern using a carpenter’s chalk line on the stage floor
or on construction paper securely attached to the stage floor.

•  The precise location of the transmitter relative to the motion capture space is
required by the StarTrak system when defining a grid.

•  Drop a plumb bob from the center of the Long Ranger transmitter to the floor.
Place a piece of tape on the floor below the plumb bob and mark the center.
Measure the X and Y center of the Long Ranger transmitter to the first grid
point in the collection process. The first grid point is the minimum X and
minimum Y distances from the transmitter. These two measurements are the X
offset and Y offset parameters defined in the StarTrak Calibration and Mapping
option.

NOTE: For most applications, minimum Y is normally a negative value and is
entered as such in the software.

•  Measure the Z offset from the stage floor to the center of the Long Ranger
transmitter. This will be defined as the Z offset in the Calibration and Mapping
option.

Data Collection

Map Setup

•  Select the “Calibration and Mapping” choice from the Tools Menu on the
StarTrak program’s main window. This will display the “Map Setup” window.

•  Map Area

This section defines the total area of the desired calibrated space (length (X) and width (Y))
and units.

1. Select Map Units, either English Standard or Metric.

2. Enter the “X distance” in feet, inches, centimeters or meters.

3. Enter the “Y distance” in feet, inches, centimeters or meters.

4. Enter the “Grid Size” in feet, inches, centimeters or meters. Note: The default
grid size is 12 inches
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•  Pole Setup

This section defines the StarPak channel, number of receivers and number of samples
averaged for each point.

1. Enter “Using channel:” as 1.

2. Enter “Receivers to Map:” as 16 or 8, depending on the number of sensors
you are using on your mapping pole.

3. Enter “Points to Average.” The default value for this is 100 samples. The
software retains new settings.

Note:  See “Pole Setup” for more information about these fields.

•  Relative Position

This is the measured offset distance between the center of the transmitter and the first
calibration point. See Figure 4-22. All measurements are made from the center of the
transmitter, which is the 0,0,0 origin location.

1. Enter “X offset:”

2. Enter “Y offset:”

3. Enter “Z offset:”

Mapping Process

•  Click on the “Start” button. This will start the collection process.

•  The Map Collection Screen will show the “(0, 0)” start point. Place the calibration
fixture at the “0.0” start point. For proper alignment of calibration fixture and grid
refer to Figure 4-7. To collect a data point, press <enter> or click the “OK” button.
The bar at the top of the screen will scroll across while the data is being
averaged and written to a file. Repeat this procedure until all of the grid points
have been collected. In the event of an error during collection, a “Back” button
deletes the previously taken data point and allows the user to retake the point.
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Figure 4-22, Calibration Region and Transmitter Offsets
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Figure 4-23  Calibration Fixture on Grid

•  Upon completion of the data collection process, select the “Save” button. In the
window “Save Map As…” give the data a filename. This file will automatically be
given the extension “. LUB.” The collected data is saved in the directory
C:\Program Files\Polhemus. (This is the compensation file.)

Apply Area Compensation File

•  Click on the “Motion View” icon from the tool bar. This will allow you to view the
Calibration Pole receivers on a graphic representation display.

•  Click on the “Setup” button. Selecting an “Area Model (LUB)” from the “Dipole”
folder turns compensation on. Click the “Area Model (LUB)” button. The “Select
Area Map” window will appear. Select the .lub file just created and Open it.

•  From the “Dipole” window select the “Apply” button. The Motion View window
will update the display from uncompensated to compensated receivers. Close
the “Options” window.
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•  View “Motion Data” for absolute and relative accuracy. The line of receivers now
should appear straight as the pole is moved through the calibrated environment.
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5 System Operation

5.1 INTRODUCTION

Using the StarTrak motion capture system requires  two human elements: (1) the 'performer(s)'
and (2) the 'operator' controlling the system.

StarTrak Performer

When immersed in a stable magnetic field, the StarTrak performer produces the motion that is
sensed by up to 16 receivers affixed to the performer’s bodysuit. The performer’s StarPak unit
collects raw data representing position and orientation. The collected data are packaged and
transmitted via wireless/single tether to the StarServe under Operator control. Up to two
performers are supported in this configuration.

StarTrak Operator

The StarTrak operator controls and monitors the motion capture process. The primary tool
used by the operator is the StarTrak application running under Windows NT.

5.2 STARTRAK MAIN WINDOW

Introduction

For the most part, the StarTrak user interface is consistent with the standard windows “look
and feel.” The StarTrak application uses a single primary window called the StarTrak Main
Window  to visually contain a series of child windows. Each child window displays data or
provides control of the StarTrak system.
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Figure 5-1,  StarTrak Main Window

Main Window Controls

For the beginning windows user, a few of the standard main window controls employed by
StarTrak are the Menu Bar, the Tool Bar, and the Status Bar.

Menu Bar

The menu bar located at the top of the main window includes a series of menu “titles” which
provide access to drop-down menus. The drop-down menus provided by the StarTrak main
window are File, View, Data, Diagnostics, Tools, and Help. Click on each title in the graphic
below for an explanation of the menu choices available there.
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Tool Bar

The Tool Bar is a series of icon buttons that allow rapid launching of commonly used views.
These views include: New Motion Capture, Open Motion Capture, Save Motion Capture,
Motion Data, Motion View, Magnetic Field Data, Characterization Data, Calibration Data and
Mapping. These views also can be launched from a menu item (see above) and are described
in detail later in this document. The toolbar is an optional feature; it may be disabled by de-
selecting “Toolbar” in the View menu.

Status Bar

The Status Bar, located at the bottom of the main window, displays time, date and system
status messages. Error messages displayed here are recorded in an error log. If the status bar
displays the presence of an error message, simply click on the status bar for a shortcut to open
the Error Log view. The Error Log view also is accessible via the View menu. The status bar is
an optional feature; it may be disabled by de-selecting “Status Bar” in the View menu.

File Menu

The file menu contains only one choice, for exiting the application. To quit StarTrak, click on
the Exit choice.

View Menu

The View menu contains choices for changing the appearance of the main window. You can
enable/disable the Toolbar and the Status Bar by clicking on the appropriate choices.

The Error Log choice launches the Error Log view. See Error Logging for more information
about this choice.
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Error Logging

Figure 5- 2, Error Log Display

The Error Log Display may be selected from the View Menu, or by clicking on the Main
Window’s Status Bar, when an error message is displayed there.

The Error Log window lists time, date and descriptions of all StarTrak system in historical
order. If the list length exceeds the window size, a scroll bar is provided. The list of errors may
be cleared with the “Clear” button or saved in a file with the “Save” button. If the “Save” button
is pressed, the log filename and the path will be requested. The “Close” button closes the Error
Log window.

Window Menu

The “Window” menu contains choices associated with managing the windows in the StarTrak
program’s workspace.

Help Menu
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The “Help” menu contains choices for getting help with your StarTrak system.

•  “StarTrak Help” launches the online version of this document.  This can also be launched by
typing the F1 key.

•  “About StarTrak” displays version information for your StarTrak and Polhemus contact
information.

About StarTrak

5.3 STATUS WINDOW

Introduction

The System Status window is always displayed within the main StarTrak application window
and provides basic control and monitoring functions for the StarTrak motion capture system.
Control buttons are located at the bottom of the window while status and configuration
information is displayed in the upper part of the window. See Figure 5-3 below.
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Figure 5- 3, Status Window

Channel Status Messages

System messages are displayed in the list boxes for both Channel 1 and Channel 2. These
messages reflect operational states of the StarPak and of the Media Access Unit (MAC). Only
the latest message is displayed in the box. Up to 20 previous messages, listed in order of

reception, may be displayed by selecting the list control  to the right of the list box.

Channel status messages are defined as follows:

"Mac NULL Message" ......................................... No MAC is installed in the
StarServe.

"Mac has Started" ................................................ MAC board is started and
waiting for communication with
StarPak.

"BP Available" ...................................................... StarPak powered up and
ready.

"BP Sensor Configuration" .................................. StarPak has reported active
sensors detected.

"Starting BP SensorA Characterization Xfr" ........ StarPak has started transfer of
even sensor characterization
data to the MAC.
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"BP SensorA Characterization Xfer Complete" .. StarPak has completed
transfer of even sensor
characterization data to the
MAC.

"Starting BP SensorB Characterization Xfr" ........ StarPak has started transfer of
odd sensor characterization
data to the MAC.

"BP SensorB Characterization Xfer Complete" .. StarPak has completed
transfer of odd sensor
characterization data to the
MAC.

"Mac Characterization Xfr Ready" ...................... MAC has received all sensor
characterization data from the
StarPak and is starting transfer
to the StarServe.

"Mac Characterization Xfr Done" ........................ MAC has completed transfer
of all sensor characterization
data to the StarServe.

"Calibration Cycle Started"................................... Calibration process has
started.

"Calibration Cycle Complete"............................... Calibration complete. The
system should now be tracking
motion.

Channel Message Rate

The StarPak data rate is displayed beneath each channel’s status message list box. The
displayed value is in “Hertz” or messages per second. Normally, this value is 120 Hz, but if
there are other applications running on the StarServe, this number may be lower.
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Channel Sensors View

From the Status view, the Channel Sensors view is displayed by clicking on the “Sensors”
button to the side of each channel message list . Each potential sensor (receiver) attached to a
StarPak is assigned a checkbox. If a sensor is not attached or not functioning correctly, the
corresponding checkbox will be disabled. Sensor data display in the Motion Data and
Diagnostic views is controlled by checking or unchecking the active sensor checkboxes. Data
will not be displayed for unchecked sensors. Checking or unchecking an active sensor box will
immediately enable or display that sensor’s data in any open Motion Data or Diagnostic views.

Note: Unchecking an active sensor box will not disable export of that sensors data over the
network connection.

Control Buttons

Start

Selecting the “START” button initiates the startup of StarTrak system components and
establishes the communications link between the server and the StarPak. The StarServe
internal MAC unit is loaded automatically with its operating software and started. Similarly the
table used to generate the Star Drive excitation is loaded and started.

Reset

The “Reset” button commands the StarPak(s) to reset but maintains the communications link.
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Sync

The “Sync” button commands the MAC to issue a precisely timed pulse to the StarPak(s) via
tether to synchronize receiver data collection with the transmitted magnetic field.

5.4 DATA VIEWS

Data Menu

The “Data” menu contains choices for viewing motion data (Position & Orientation data)
reported by the receivers worn by the performer.

“Motion Data” presents P&O data for each receiver in tabular format.

“Motion View” presents position data only for each receiver in a graphical format. Orientation
data is not available in this view.
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Motion Data

Figure 5- 4, Motion Data Display

Select the Motion Data item from the Data menu or select the  icon from the Tool Bar to
invoke the Motion Data window (Figure 5-4). This window presents calculated position and
orientation data for any active receiver on channel 1 or channel 2. Position information is
displayed in inches or centimeters depending on the preference selected in the Format Tab of
the Options view. (See section 5.6). Orientation is displayed in Euler angles. From left to right,
the columns are X, Y, Z, Azimuth, Elevation, and Roll.

Polhemus uses an AEROSPACE standard coordinate system. This is a right-handed
coordinate system where +Z is down; +X and +Y are defined during the mapping process.

Azimuth, Elevation, and Roll are 0, 0, 0 when a receiver is in line with the +X axis, and the flat
part of the receiver is facing downward. The receiver cable is considered the 'tail' and comes
out the rear (-X side) of the receiver. Converting from Azimuth, Elevation, and Roll to another
standard is a topic covered in the programmer's API, available from customer service.
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Motion View

Figure 5- 5 Motion View Window

For a quick graphical peek of the receivers on the performer, select “Motion View” from the

Data Menu item or select the  icon from the Tool Bar. The window presented (Figure 5-5)
displays active sensors (receivers) as colored circles within a predefined 15’ x 15’ x 15’ motion
capture area. Circles outlined in white represent sensors (receivers) from Channel 1, and
sensors (receivers) from channel 2 are outlined in black. The Motion View displays only
position data. Orientation is not available  here.

One of three “points of view” may be selected: (1) Front, (2) Side and (3) Top. In each case the
red, stationary ball represents the transmitter (Long Ranger or Super Nova). For the Front view
the transmitter is located in back of the receivers (eye level in the case of a Long Ranger).

NOTE: The calibration table algorithm does not necessarily compensate receivers that go to
the physical edges of a calibrated volume.  Occasional erratic performance can be noted in
receivers at such edges since they may encounter the uncalibrated region.  Please note that
this applies to all directions of the volume, i.e. X, Y, and Z.
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5.5 DIAGNOSTIC VIEWS

Diagnostics Menu

The “Diagnostics” menu contains choices for troubleshooting your StarTrak system.

•  “Magnetic Fields” displays unprocessed sensor data collected by the StarPak.

•  “Characterization Data” displays factory measured data stored in each active receiver.

•  “Calibration Data” displays calibration responses generated by the StarPak electronics.

Magnetic Field Data

Figure 5- 6 Magnetic Field Data Window
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To launch the magnetic field data window select “Magnetic Fields” from the Diagnostics Menu

or select the   icon from the Tool Bar. The Magnetic Field data window view (Figure 5-6)
shows the unprocessed receiver data collected by the StarPak(s). The data are only useful for
system diagnostics and troubleshooting.

Characterization Data

Figure 5- 7 Characterization Data Window

The characterization data window (Figure 5-7) is displayed upon the selection of the

“Characterization Data” list item from the Diagnostics Menu, or by selecting the  icon from
the Tool Bar. This window reflects factory measured data stored in every active receiver. This
data includes the receiver serial number and coil responses to excitation frequencies. Figure 5-
7 above shows what the coil response characterization data should look like.

Channel 1 or Channel 2 characterization data may be displayed. To increment through the
available receivers, select the “next” button. To decrement through the sensor list, select the
“previous” button. The “cancel” button closes this window.
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Calibration Data

Figure 5- 8 Calibration Data Window

The calibration data window (Figure 5-8) is obtained by selecting  the “Calibration Data” choice

from the Diagnostics Menu or by selecting the  icon from the Tool Bar. This window
reflects coil and frequency responses to a precise signal generated on board the StarPak.
Figure 5-8 above shows what these responses should look like.

Channel 1 or Channel 2 calibration data may be displayed. To increment through the available
receivers, select the “next” button. To decrement through the sensor list, select the “previous”
button. The “cancel” button closes this window.

5.6 TOOLS

Tools Menu

The “Tools” menu contains choices for a variety of useful tools for operating, calibrating, and
characterizing your StarTrak system.

•  “Calibration and Mapping” launches the “Map Setup” view, the first step in calibrating your
environment.

•  “Reset Algorithm” restarts the P&O algorithm.
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•  “Options” launches the StarTrak application’s main options dialog. All configurable settings
for the application are accessed here.

Reset Algorithm

Selecting the “Reset Algorithm” list item restarts the P&O algorithm. Resetting this algorithm is
rarely required, but the option is provided for troubleshooting purposes.

Calibration and Mapping

Introduction

For an accurate representation of a receiver’s position and orientation within a volume, the
volume must be calibrated. Start the calibration process by selecting “Calibration and Mapping”

choice from the Tools Menu, or by selecting the  icon from the Tool Bar. Refer to the
Environment Model chapter for a full discussion of the calibration (mapping) process.
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Figure 5- 9, Map Setup Window

The “Map Setup” window (Figure 5-9) provides a means for inputting map specific data prior to
starting the calibration process. Three frames require input: “Map Area,” “Pole Setup” and
“Relative Position.”

Measurements input into this view can be expressed in either metric or English units. Select
the system you wish to use with the “Map Units” selection, found in the “Map Area” section of
the view. Depending on the system selected here, each input measurement may be specified
in either feet/inches (for English) or meters/centimeters for metric.

See “Define the Mapping Grid” and  “Map Setup” for a detailed explanation of how to use this
view.

Map Area
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Specify the volume of the area to be mapped by entering values in the “X distance” and “Y
distance” fields.

The “Grid size” field is used to specify the distance between points to be mapped. See “Define
the Mapping Grid” for a detailed explanation of the use of this field.

Use the “Map Units” field to specify English Standard or Metric units for expressing the X- and
Y- distances.

Pole Setup

The “Pole Setup” frame is used to specify mapping parameters that relate to the calibration
fixture.

The fixture uses a StarPack on Channel 1 only.

It can be configured to use either 8 or 16 sensors to gather data. Configure this by using the
“Sensors to map” field.

The “Points to Average” field defines how much data is gathered at each point. The default
value here is 100 frames. That is, one hundred data samples will be taken and averaged at
each grid location to acquire a calibration table value. The 100-frame default value should be
satisfactory in most circumstances.

See “Map Setup” for a detailed explanation of how to use these fields.

Relative Position

The “Relative Position” frame is used to specify the measured offset distances between the
center of the transmitter and the first calibration point. See “Define the Mapping Grid” for an
explanation of how to measure these distances.
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  Note:  In version 1.0, the units of measurement used to specify the distances in the “X-,”
“Y-“ and “Z offset” fields is always INCHES.  It is not affected by the setting of the “Map Units”
field in the “Map Area” frame at the top of the view.

Map Collection

Figure 5- 10, Map Collection  Window

The “Map Collection” window (Figure 5-10 above) hosts the active portion of the mapping
process. It displays a grid representing the (X, Y) dimension of the mapping volume. The Z
dimension is defined by the sensors affixed to the calibration pole. Cells within the grid are
filled with color as pointers to the next data collection position. Each square represents a
position at which the calibration pole will be placed and data collected. As the map collection
progresses, cells in the grid are filled in sequentially, in the “serpentine” pattern that the
calibration pole is moved through the mapping volume.

The progress bar above the mapping grid indicates the relative progress of data collection and
averaging within an (X, Y) cell of the mapping grid. The rate of progress is proportional to the
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number of points to be averaged previously specified in the “pole setup” portion of the map
setup window .

There are three buttons associated with the control of the mapping process.

The “OK” button starts the collection and averaging process for one mapping cell. When all
data for a cell has been collected and averaged an audible “beep” is issued from the
StarServe, and the next square in the grid will be highlighted, indicating the next point to be
collected.

The “Back” button allows for recollection of data at previous points. Click on this button once to
re-collect data in the previous cell. Repeated clicking on this button will “back up” the process
to the desired cell. All cells “backed up” over will then be re-collected in sequence.

The “Cancel” button commits no data collected to storage, closes the “Map Collection” window
and brings the “Map Setup” window to the foreground.

See “Mapping Process” for step-by-step instructions on the use of this view.

Options Window

Introduction

The Options window, accessed via the Tools Menu, allows for the configuration of StarServe
functions and features such as MAC boot and lookup table files, Network configuration, P&O
algorithm, RF link configuration and system units of measure.

To use the Options window, select the settings you wish in any or all of the options tabs, and
click OK. To cancel your selections, click Cancel. To apply your selections without dismissing
the Options window, click Apply.
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File Locations Tab

Figure 5- 11 File Location Options Tab

There are two primary startup files used by the Media Access Controller within the StarServer.
Selecting this tab  displays the name of each file. Searching for and specifying each filename
is possible through corresponding edit boxes and pop up dialog boxes.

As will all of the Options window tabs, selections may be applied by clicking “OK” or “Apply,” or
discarded by clicking “Cancel.” Clicking “OK” will also dismiss the Options Window.
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Network Tab

Figure 5- 12 Network Configuration Options Tab

If motion data is to be exported, the Network configuration tab is used to enable the UDP
transport. set the network transport protocol may be specified as well as the data format and
the destination address.

When the UDP transport is enabled, other transport configuration parameters must be
specified.

First, the format of the exported data must be specified. Typically, the binary format is
preferable because it is more compact and gives better performance. However, the ASCII
format may be preferred occasionally when a human-readable form is desired.

The destination IP is the address of the machine listening to the StarServer. This address is of
the form aaa.bbb.ccc.ddd where a, b, c, and d are numbers from 0 to 255.. To broadcast
motion data to all computers on the network, set the destination to 255.255.255.255.
Broadcasting can put a heavy load on the network; it is not recommended for networks that
also have other purposes.

The Destination Socket is a unique number that needs to match the socket used by the
machine listening to the StarServe. This socket number refers to the UDP port number and is
an integer between 1025 and 32767.

As a rule of thumb, the source and destination machines should have similar IP addresses. For
example, if the destination machine’s address is 128.0.0.1, the source machine’s address
should be 128.0.0.x where x is between 1 and 254.
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As will all of the Options window tabs, selections may be applied by clicking “OK” or “Apply,” or
discarded by clicking “Cancel.” Clicking “OK” will also dismiss the Options Window.

Dipole Tab

Figure 5- 13, Dipole Settings Options Tab

The Dipole Settings tab (Figure 5-13) is used to configure the Dipole P&O algorithm that
StarTrak employs. The configurable parameters are described below.

Area Model

The Area Model is the Look-up Block (.LUB) file that is created by the mapping process. When
no file is specified here, the StarTrak’s P&O algorithm applies no compensation for magnetic
field distortions in the motion capture area. Most indoor environments in the presence of metal
objects or construction require compensation. A typical installation will have only one Area
Model (produced by performing the Mapping and Calibration procedure), but it is possible to
have more than one. The "Browse" button allows selection of the Area Model .LUB file.

See the “Environmental Model” chapter for step-by-step instructions on calibrating your
environment.
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Filter

The Filter is a motion filter that may be needed to smooth performance. Filtering may be
disabled by selecting “none” in this field, or medium or heavy filtering may be selected. When
filtering is applied, the Dipole P&O algorithm will “smooth” its results to lessen the effects of
extremely quick movements or momentary glitches or distortions.

Hemisphere

The StarTrak system allows operation in one hemisphere at a time of coverage relative to the
Long Ranger transmitter. The hemisphere command defines the desired hemisphere of
operation. Basically, the user should choose one side of the transmitter where the receivers
will always be and specify that side as the hemisphere of operation. There are six selections
and are as follows:

 1, 0, 0 +X

-1, 0, 0 -X

 0, 1, 0 +Y

 0,-1, 0 -Y

 0, 0, 1 +Z

 0, 0, -1 -Z

The X, Y and Z components of the Hemisphere vector determine the base orientations of the
three field components. The default value of (1, 0, 0) indicates that the “forward” hemisphere is
selected. This means that if the performer is standing in front of the transmitter, positive X is
straight ahead, positive Y is to the right, and positive Z is straight down.

As will all of the Options window tabs, selections may be applied by clicking “OK” or “Apply,” or
discarded by clicking “Cancel.” Clicking “OK” will also dismiss the Options Window.
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RF Link Tab

Figure 5- 14, RF Link Options Tab

Selection of the RF Link Tab (Figure 5-14) displays and allows modification of each StarPak’s
wireless channel and sub channel. Select the RF channel and (spreading code) subchannel
from the appropriate dropdown lists. There are 12 RF channels and 4 subchannels to choose
from.

When two StarPaks are used, selection of the RF channels is critical. At least a 4 channel
separation (between the two StarPaks) must be observed for effective communication.
Additionally, channel 1 should never be used in a multi StarPak configuration.

As will all of the Options window tabs, selections may be applied by clicking “OK” or “Apply,” or
discarded by clicking “Cancel.” Clicking “OK” will also dismiss the Options Window.

  Note:  The available RF channel selections are pre-programmed to according to
communications regulations in the country in which the StarTrak is deployed.
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Format Tab

Figure 5- 15, Format Options Tab

From the Format options tab, you may select your numeric system preferences. This setting
dictates the units in which the P&0 data will be displayed in the Motion Data view, as well as
the default units of measurement used throughout the StarTrak program.

As will all of the Options window tabs, selections may be applied by clicking “OK” or “Apply,” or
discarded by clicking “Cancel.” Clicking “OK” will also dismiss the Options Window.
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6 Exporting Data

6.1 INTRODUCTION

To export keyframed motion data over a network UDP connection, enable the UDP option in
the Network Tab of the Options view. See the Network Tab topic in Section 5.7. You must also
set the IP address of the client machine, and the UDP port number that the client process is
listening on. Make sure that the port number you select does not conflict with other processes
that may be listening on the client machine. You may also specify whether the motion capture
data will be exported in ASCII or BINARY. Binary is the most compact form and is
recommended for minimum lag. However, ASCII may be preferable in certain circumstances
where it is necessary to examine the data visually.

Once enabled, the StarTrak system will begin exporting captured data immediately.

6.2 DATA FORMAT

The format of each exported data frame is as follows:

Header: Frame 023 FrameSize 736 HeaderSize 056 RecordSize 085
<cr><lf>

Body:   a011 <x pos> <Y pos> <Z pos> <Azimuth> <Elevation> <Roll>
<cr><lf>

Body:   a111 <x pos> <Y pos> <Z pos> <Azimuth> <Elevation> <Roll>
<cr><lf>

Body:   a211 <x pos> <Y pos> <Z pos> <Azimuth> <Elevation> <Roll>
<cr><lf>

Body:   a311 <x pos> <Y pos> <Z pos> <Azimuth> <Elevation> <Roll>
<cr><lf>

Body:   a012 <x pos> <Y pos> <Z pos> <Azimuth> <Elevation> <Roll>
<cr><lf>

Body:   a112 <x pos> <Y pos> <Z pos> <Azimuth> <Elevation> <Roll>
<cr><lf>



Star★★★★ Trak User Guide v001B

Exporting Data 6-79

Each frame of data consists of a header and a body. The header is always ASCII. The header
information consists of the following fields:

Frame Number: Integers from 0 to 999. Frame number rolls over at 999.

Frame Size: The number of bytes in the frame.

Header Size: The number of bytes in the header.

Record Size: The number of bytes in each record of the body portion of the frame.

The body of the frame contains position/orientation records for each active sensor. Each
record begins with an encoded ASCII 4-character sequence that indicates the following
information about the record:

StarTrak identifier: This is always the lower-case letter a.

Sensor number: Hexadecimal number 0 through F

New Data Flag: Always 1.

Channel Number: 1 or 2.

Next, each record contains position and orientation data fields. The P&O data may be ASCII or
binary, depending on the preferences set in the Options tab. The X, Y, Z position data may be
expressed in either CM or INCHES, depending of preferences set in the Format Tab in the
Options View. Orientation data is expressed as Euler Angles azimuth, elevation, and roll. Euler
angles are expressed in degrees.

Figure 6.1 shows sample ASCII data of four sensors on each channel.

Frame 023 FrameSize 736 HeaderSize 056 RecordSize 085<cr><lf>

a011 -1.12345E-01 -2.12345E-02 -3.12345E-03 -0.12345E-00 -1.12345E-01 -
2.12345E-03 <cr><lf>

a111  1.12345E-01  2.12345E+02  3.12345E+03  0.12345E+00  1.12345E+01
2.12345E+03 <cr><lf>

a211 -1.12345E-01 -2.12345E-02 -3.12345E-03 -0.12345E-00 -1.12345E-01 -
2.12345E-03 <cr><lf>

a311  1.12345E-01  2.12345E+02  3.12345E+03  0.12345E+00  1.12345E+01
2.12345E+03 <cr><lf>

a012 -1.12345E-01 -2.12345E-02 -3.12345E-03 -0.12345E-00 -1.12345E-01 -
2.12345E-03 <cr><lf>

a112  1.12345E-01  2.12345E+02  3.12345E+03  0.12345E+00  1.12345E+01
2.12345E+03 <cr><lf>

a212 -1.12345E-01 -2.12345E-02 -3.12345E-03 -0.12345E-00 -1.12345E-01 -
2.12345E-03 <cr><lf>
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a312  1.12345E-01  2.12345E+02  3.12345E+03  0.12345E+00  1.12345E+01
2.12345E+03 <cr><lf>

Figure 6-1  Sample Data
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7 Maintenance

7.1 INTRODUCTION

The StarTrak system contains sensitive electronic components that require special attention.
Information on the safest way to use StarTrak, how to care for your system, creating the ideal
work environment and moving your system is included in this chapter.

7.2 MAINTAINING  A SAFE WORK ENVIRONMENT

Except as explained elsewhere in this manual, do not attempt to service the StarTrak system
yourself.

To avoid damage to the StarTrak system and monitor, use the correct type of alternating
current (AC) power 90 – 230V and 50/60Hz

To prevent electric shock, plug your StarTrak's power cable into a properly grounded electrical
outlet. If you use an extension cable, use a 3-prong extension cable. Do not handle the
transmitter(s) while operating.

If the StarTrak is dropped or damaged, contact Polhemus Incorporated for technical
assistance.

7.3 CARING FOR YOUR STARTRAK SYSTEM

Before cleaning your StarTrak, unplug it. Use a cloth dampened with water or cleaning
solution. Do not apply liquid, thinner, oil, petroleum or aerosol cleaners directly to the StarTrak.

Do not probe the inside of your StarTrak; the power supply contains high voltage.

7.4 TRANSPORTING THE STARTRAK SYSTEM

When moving the StarTrak system, use the following precautions:
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•  Turn off all components.

•  Disconnect all cords and cables.

•  Coil cables and tape them to the system unit.

•  Repackage the StarTrak system in its original packing materials.

•  Remember that the new site will require an environment modeling &
calibration and that the return of the system to its original operating site may
require re-calibration depending on the precision of the replacement of the
transmitter(s) from their original location.
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8 Technical Support

8.1 TECHNICAL SUPPORT

If you encounter a problem while using your StarTrak system please try to note the symptom,
the software module that the problem occurred in (i.e., starmap.exe, startrak.exe,
dos4gw.exe), and what the configuration of the system was at the time the error occurred.
Then, call (800) 357-4777 (USA or CANADA) or (802) 655-3159, ext. 242, for Customer
Service. Our customer service engineers can provide assistance over the telephone. If the
problem requires any repairs, the Customer Service engineer will issue you a Return
Merchandise Authorization (RMA) number. We recommended keeping the original shipping
container for your StarTrak  in the event that it needs to be shipped or moved. Please do not
return any equipment without an RMA number, as it will not be accepted. If your equipment is
still under warranty, Polhemus will repair it free of charge according to the provisions of the
warranty as stated in Chapter 9. The proper return address is:

Polhemus Incorporated

1 Hercules Drive, P.O. Box 560

Colchester, Vermont  05446-0560

Telephone (voice): (802) 655-3159, or  (800) 357-4777 (U.S. and Canada only)

Telephone (FAX): (802) 655-1439

E-mail (Technical Support): techsupp@polhemus.com

Web Home Page: http://www.polhemus.com
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9 Important Information

9.1 WARRANTY & LIABILITY

Polhemus Incorporated (PI) warrants that the System shall be free from defects in material and
workmanship for a period of one year from the date ownership of the System passes from PI to
Buyer. PI shall, upon notification within the warranty period, correct such defects by repair or
replacement with a like serviceable item at PI's option. This warranty shall be considered void
if the System is operated other than in accordance with the instructions in PI's User Manual or
is damaged by accident or mishandling. Parts or material that are clearly expendable or
subject to normal wear beyond usefulness within the warranty period such as lamps, fuses,
etc., are not covered by this warranty.

In the event any System or portion thereof is defective, the Buyer shall, within the warranty
period, notify PI in writing of the nature of the defect, under the direction of PI determine and
remove the defective parts, ship such parts to PI. Upon determination by PI that the parts or
Systems are defective and covered by the warranty set forth above, PI, at its option shall repair
or replace the same without cost to the Buyer. The Buyer shall pay all charges for
transportation and delivery costs to PI's factory for defective parts where directed to be sent to
PI, and PI shall pay for transportation costs to the Buyer's facility for warranty replacement
parts and Systems. Removed parts covered by claims under this warranty shall become the
property of PI.

In the event that allegedly defective parts are found not to be defective, or are not covered by
warranty, Buyer agrees that PI may invoice Buyer for all reasonable expenses incurred in
inspecting, testing, repairing and returning the System and that the Buyer will pay such costs
on being invoiced therefor. The Buyer shall bear the risk of loss or damage during transit in
such cases.

Any repaired or replaced part of a System shall be warranted for the remaining period of the
original warranty or thirty (30) days, whichever is longer. Warranties shall not apply to any
Systems which have been: repaired or altered other than by PI, except when so authorized in
writing by PI; used in an unauthorized or improper manner, or without following normal
operating procedures; or improperly maintained and where such activities in PI's sole
judgement, have  adversely affected the System. Neither shall warranties apply in the case of
damage through accidents or acts of nature such as flood, earthquake, lightning,  tornado,
typhoon, power surge or failure, environmental extremes, or other external causes.
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PI does not warrant and specifically disclaims the warranty of merchantability of the products
or the warranty of fitness of the products for any particular purpose. PI makes no warranties,
express or implied, except of title and against patent infringement, other than those specifically
set forth herein.

In no event shall PI be liable under any circumstances for special incidental or consequential
damages, including, but not limited to loss of profits or revenue. Without limiting the foregoing,
PI's maximum liability for damages for any cause whatsoever, exclusive of claims for patent
infringement and regardless of the form of the action  (including but not limited to contract
negligence or strict liability) shall be limited to buyer's actual direct damages, not to exceed the
price of the goods upon which such liability is based.

9.2 INDEMNITY AGAINST PATENT INFRINGEMENT

Polhemus Incorporated (PI) shall have the right at its own expense, to defend or at its option to
settle, any claim, suit or proceeding brought against the Buyer on the issue of infringement of
any United States patent by any product, or any part thereof, supplied by PI to Buyer under
this Agreement. PI shall pay, subject to the limitations hereinafter set forth in this paragraph,
any final judgment entered against the Buyer on such issue in any such suit or proceeding
defended by PI. PI at its sole option shall be relieved of the foregoing obligations unless the
Buyer notified PI promptly in writing of any such claim, suit or proceedings, and at PI's
expense,  gave PI proper and full information and assistance to settle and/or defend any such
claim, suit or proceeding. If the product, or any part thereof, furnished by PI to the Buyer
becomes, or in the opinion of PI may become, the subject of any claim, suit or proceeding for
infringement of any United States patent, or in the event of an adjudication that such product or
part infringes any United States patent, or if the use, lease or sale of such product or part is
enjoined, PI may, at its option and its expense: (a) procure for the Buyer the right under such
patent to use, lease or sell, as appropriate, such products or part, or (b) replace such product
or part, or (c) modify such product, or part, or (d) remove such product or part and refund the
aggregate payments and transportation costs paid therefore by the Buyer less a reasonable
sum for use, damage and obsolescence.  PI shall have no liability for any infringement arising
from: (i) the combination of such product or part with any other product or part whether or not
furnished to Buyer by PI, or (ii) the modification of such product or part unless such
modification was made by PI, or (iii) the use of such product or part in practicing any process,
or (iv) the furnishing to the Buyer of any information, data, service or application assistance.
The Buyer shall hold PI harmless against any expense, judgment or loss for infringement of
any United States patents or trademarks which results from PI's compliance with the Buyer's
designs, specifications or instructions. PI shall not be liable for any costs or expenses incurred
without PI's written authorization and in no event shall PI's total liability to the Buyer under, or
as a result of compliance with, the provisions of this paragraph exceed the aggregate sum paid
to PI by the Buyer for the allegedly infringing product or part, exclusive of any refund under
option (iv) above. The foregoing states the entire liability of PI, and the exclusive remedy of the
Buyer, with respect to any actual or alleged patent infringement by such product or part.

9.3 FCC STATEMENT

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against interference when the equipment is operated in a commercial environment.
This equipment generates, uses, and can radiate radio frequency energy and, if not installed
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and used in accordance with instructions in this manual, may cause interference to
communications signals. Operation of this equipment in a residential area may cause
interference, in which case the user will be required to correct the interference at his own
expense. This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device must not cause harmful interference, and (2) this
device must accept any interference that may cause undesired operation.

 RF Exposure For Wireless Option

WARNING: To satisfy FCC RF exposure requirements for mobile transmitting devices,
a separation distance of 20 cm or more should be maintained between the antenna of
this device and persons during device operation. To ensure compliance, operations at
closer than this distance is not recommended.
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